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WAS v7 Programming Model Goals
=One word ......... Simplify

» Simplify the programming model

» Simplify application assembly / packaging
» Simplify testing

» Simplify Object Relational Mapping

» Simplify Web Services Development

/4 o S
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Agenda

= Java Enterprise Edition (Java EE) 5
» EJB 3.0
» JPA

= Web Services
» JEE 5
» WS*

= Application Development Tooling
» Rational Application Developer (RAD)

WASv7.,Java EE 5 tools & RAD 7.5
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WAS V7 supports Java EE 5

= Java annotations (JSR 175)
= Enterprise JavaBeans (EJB) 3.0
= Java Persistence API (JPA)
= Web services (JAX-WS 2.0)

= Web application technologies
» JSP 2.1 ( Java Server Pages)
» JSF 1.2 ( Java Server Faces)
» Servlet 2.5

© 2008 IBM Corpora tion WASv7.,Java EE 5 tools & RAD 7.5
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@Annotations

= Java EE 5 annotations let you embed resources,
dependencies, services, and life-cycle notifications
directly in your source code

» Replace descriptors for most purposes
» Reduce the number of artifacts you have to maintain

» Allow application settings to be visible in the component
they affect

= Can be used, e.g., when:
» Developing Enterprise JavaBeans applications

» Defining and using Web services
» Mapping Java technology classes to databases

WASv7.Java EE 5 tools & RAD 7.5
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Annotation based Dependency Injection

= Resource dependencies can be declared using
annotations

» Inversion-of-Control (loC) pattern eliminates boilerplate
code and lets the container do the work

» No longer need to use factories to get objects from JNDI

= Examples:
» @EJB ShoppingCart myCart
» @QResource DataSource bankDS

= WAS v7 uses dependency injection to avoid clutter,
allowing you to focus on business logic...

WASv7.,Java EE 5 tools & RAD 7.5
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Security Annotations and Authorization

= Annotations can be used for role-based
authorization

= Provide equivalent functionality to:

» <security-role>, <method-permission>, <run-as>,
<exclude-list>

* Five annotations are supported:
» Servlets: @DeclareRoles and @RunAs

» EJB: @DeclareRoles, @DenyAll, @PermitAll,
@RolesAllowed, @RunAs

© 2008 IBM Corporation WASv7.,Java EE 5 tools & RAD 7.5
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EJB 3 Programming Model

= Two types of EJBs:
» Session beans (stateless and stateful)
» Message driven beans

= A complete new persistency model
» based on the JPA standard
» supersedes EJB 2.x entity beans

= Make it as easy as possible to implement simple
things, while keeping complex things possible

mesm)>  Simplification

WASv7.,Java EE 5 tools & RAD 7.5
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Simplifying EJB

= EJBs are now POJOs
» Expose regular business interfaces
» No need to implement javax.ejb.SessionBean
» Interfaces no longer have to implement EJBObject
» No longer have to throw RemoteException
» Home interfaces no longer required

» EJB implementations no longer required to implement
EJB life cycle methods. Use callback annotations instead.

WASv7.,Java EE 5 tools & RAD 7.5
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Example: Simplifying EJB - continued

EJB 2.1 EJB 3.0

public interface ShoppingCart public interface ShoppingCart
extends EJBObject { {

o public int
pggrlf:"?egﬁoppingl‘qlethod{) ez,

throws RemoteException;

}

EJB 2.1 EJB 3.0

Object obj = @EJB

Context lookup(*java.comp/env/ejb/ ShoppingCart myCart:
MyCartHome"); '

CartHome theCartHome = (CartHome)
FortableRemoteObject. narrow(obj,
CartHome class);

myCart. someShoppingMethod();

ShoppingCart myCart =
theCartHome create() ;

myCart.someSshoppingMethod();

© 2008 IBM Corporation WASv7.,Java EE 5 tools & RAD 7.5
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EJB 2.1 Descriptor vs EJB 3.0

EJB 2.1

EJB 3.0

<gjb-Jar=
<Enterprise-beanss
<SESSI0N=

=gjb-name=AccountTransferController=/gjb-name:>

classs
<3essi0n-typexstateless</session-types=
<fransaction-type=Container</Aransaction-type:=
=/se55i0N=
=<fenterprise-heans:=
<assembly-descriptors
<container-transaction:=
<method=
<gjb-name=AccountTransferController</ejb-name:
<method-name>*</method-name:=
</method=
<trans-attribute=Required</trans-attribute =
<fcontainer-transaction:=
<fassembly-descriptors
=/ejb-jar=

=description=Account Transfer Controller EJB </description=
=display-name=Account Transfer Controller EJB=/display-name >

<home=com.mycompany AccountTransferControllerdome</home:
<remote=com. mycompany AccountTransferController=/remates (.}
<gjb-class=com.mycompany AccountTransferController mpl</ejo-

@stateless

© 2008 IBM Corporation

public class AccountTransferControllerBean
implements AccountTransferController {

public void transfer(Account src, Account, dest, float amount)

throws InsuficientFundsException

WASv7.,Java EE 5 tools & RAD 7.5
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Annotations vs EJB Deployment Descriptor

= EJB deployment descriptors are now optional
» Used to override information specified in the annotations.

» Can be sparsely populated. No entries needed except to override
defaults.

» Can be used as an alternative to annotations or in combination.

= Annotations assume the obvious — but allow specification of
non-default values.

» Configuration by Exception

= Annotations to allow specification of meta-data, making
deployment descriptors optional

» @Stateless stateless session bean
» @Stateful stateful session bean
» @MessageDriven message-driven bean

» @Entity JPA entity

WASv7.,Java EE 5 tools & RAD 7.5
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WAS V7 EJB Backward Compatibility

= EJBs 1 and 2 are still supported by WAS v7 EJB container

= To call an older bean from an EJB 3.0 bean:

» Inject the home interface
QEJB

private CustomerHome customer;
= To call an EJB 3.0 bean from an older bean:
» Add an EJB reference to lookup the business interface

Customer3 customer =
(Customer3) ctx.lookup ("java:comp/env/Customer3");

= Or look up the home interface and use the bean just as you
would an older bean

= The EJB 3.0 bean must have a home interface, and a component
(EJBObject/EJBLocalObject based) interface

WASv7.,Java EE 5 tools & RAD 7.5
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The Object Relational Mapping Challenge

= Persistence is a challenge in EJB 2.1
» Complex programming model
» Entity beans considered too heavyweight
» EJB-QL considered too limited

= Other approaches have emerged in response
» Custom frameworks or plain JDBC™

» Object-relational mapping (ORM) solutions
= Hibernate
= OpendPA
= Toplink (now EclipseLink)
= Others

WASv7.,Java EE 5 tools & RAD 7.5



| IBM Software Group

Java Persistence API (JPA)

= JPA is a standard persistence and object-relational
mapping (ORM) framework for Java
» Part of the EJB 3.0 specification (JSR220)
» Provided by the javax.persistence package

= Enables persisting POJOs to a relational database

= No deployment code or abstract classes
= No interfaces required

» Metadata is specified with Java annotations or in XML
deployment descriptors

= JPA is available in both Java SE and Java EE
environments

WASv7.,Java EE 5 tools & RAD 7.5
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Entity Bean vs JPA

EJB 2.1 Entity Bean

© 2008 IBM Corporation

public abstract class CustomerBean implements
Customer, EntityBean {

public CustomerBean() { }

public abstract String getName();
public abstract void setName(String n);
public abstract int getAmountSpent();

public abstract void setAmountSpent(int
amount);

private EntityContext ctx;

public String ejbCreateByName(String) throws
EJBException { }

public void setEntityContext (EntityContext
theCtx) throws EJBException {

ctx = theCtx; }

public void unsetEntityContext() throws
EJBException {

ctx = null; }

« W a5

JPA

@Entity @Table (name=“CUSTS”)

public class Customer implements Serializable {
public Customer() { }
@Id
public String getName() { return name; }
public void setName(String n) { name = n;}

public int getAmountSpent() { return
amountSpent; }

public void setAmountSpent(int a) {
amountSpent = a; }

private String name;
private int amountSpent;

WASv7.,Java EE 5 tools & RAD 7.5
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Web services: Java EE 5 - Standards

= Java API for XML Web services (JAX-WS)
» Supersedes JAX-RPC
» Simplified Web service development

» Standardized programming model for using WS-
Addressing

= JAXB 2.1 for simpler XML to Java mappings,
iIncluding improved support for XML type
substitution

= StAX 1.0 for high-performance streaming parsing

© 2008 IBM Corporation WASv7.,Java EE 5 tools & RAD 7.5
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JAX-WS Web Services

= Support for generic XML/HTTP as a protocol binding

» Create clients and providers that do not use SOAP for their wire level
message format

= Asynchronous support for clients
» Using either a polling or callback mechanism

= Supports Message Transmission Optimization Mechanism
(MTOM)

» Improved method for sending binary attachments

= As in JAX-RPC, JAX-WS provides a mechanism for
application handlers

» Insert or retrieve data from a message as it moves through the Web
services engine

WASv7.,Java EE 5 tools & RAD 7.5
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JAX-WS Web Services Tools

= WSImport

» for top down development

= Create a Web service form a WSDL
= JAX-WS equivalent of WSDL2Java

= WSGen

» for bottom up development

= Create a Web service from Java code
= JAX-WS equivalent of Java2WSDL

= Java SE 6

»1| Classes

by

. WA
43
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JAX RPC vs JAX-WS

JAX-RPC 1.1 Code JAX-WS 2.0 Code
public interface StockQuote @WebService
extends Remote | public interface StockQuote {
public float getQuote(String sym) public float getQuote(String sym);
throws RemoteException; }
) @WebService

. . public class QuoteBean implements
public class QuoteBean implements StockQuote |

{ @WebMethod

|{oubli}c float getQuote(String sym) public float getQuote(String sym)

WASv7.,Java EE 5 tools & RAD 7.5
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WAS v7 WS* Standards

= Support for OASIS standards
» Emphasize interoperability (with, for example .NET):

= WS-I profiles:
» WS Reliable Secure Profile
» Basic Profile 1.2 and 2.0

= WS-ReliableMessaging
= WS-SecureConversation
= WS-Trust

WASv7.,Java EE 5 tools & RAD 7.5
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Additional WAS V7 WS* Standards

= WS-Transaction

= WS-SecurityPolicy

= Kerberos Token Profile

= W3C WS-Policy

= W3C WS-Addressing Metadata
= W3C SOAP 1.2

= W3C MTOM and XOP

= WS-MetadataExchange

© 2008 IBM Corpora tion WASv7.,Java EE 5 tools & RAD 7.5
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WAS v7 Standards

= WAS v7 Standards
» http://publib.boulder.ibm.com/infocenter/wasinfo/v7r0/inde

X.[sp?topic=/com.ibm.websphere.nd.multiplatform.doc/info
/ae/ae/rovr_specs.html

= Web Sevices Standards

» http://publib.boulder.ibm.com/infocenter/radhelp/v7r5/inde
X.[sp?topic=/com.ibm.webservice.wsfp.doc/topics/cwsfpst
andards.html
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RAD 7.5: Background

= Rational Application Developer (RAD) 7.5
» Based on Eclipse 3.4

= |BM’s IDE for WAS 7
» Has built-in WAS 7 server for testing purposes

= RAD 7.5 can also create & test older, J2EE 1 .4,
1.3, and 1.2 applications

_ E o
© 2008 IBM Corpora tion WASv7.,Java EE 5 tools & RAD 7.5
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Annotation support in RAD 7.5

= While editing Java files annotations can be added
using the content assist function
» Type ‘@’ then hit ctrl+space to display a list of available

annotations including annotations for

= EJB 3.0
= JAX-WS
= JPA

= The editor provides validation for annotations while
you type

= Annotations are also able to be edited, added, and
removed using the new Annotation view

WASv7.,Java EE 5 tools & RAD 7.5
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Content assist helps add annotations

@5tateless
public class TestSessionbBean implements TestSessionBeanRemote, TestSessiond

g

(™ Deprecated - java.lang A program element annotated @Deprecated is one
1 @ sigtel : - —| that programmers are discouraged from using,
=55 T JAVEN.E] typically because it is dangerous, or because a better
@ override - java.lang alternative exists. Compilers warn when a deprecated
@ SuppressWarnings - java.lang Elmgram tz!:me;t is used or overridden in non-
@ action - javan. xml. ws =precatid code.
Author:
@ ActivationConfigProperty - javax.ejb Neal Gafter
@ Addressing - javax.xml.ws.s0ap Since:

] 1.5
@ AnnogenInfo - org.codehaus.annogen.geners Sversion

g ApplicationException - javax.ejb | 1.5, 11/17/05
! |

Press "Crrl+Space’ to show Template Proposzls

© 2008 IBM Corporation WASv7.,Java EE 5 tools & RAD 7.5
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The Annotation view

B Problems | 4] Tasks | ] Properties | 45 Servers YR8 Data Source Explorer ﬂEI &mmm

£ @& B 3| ~ atbutes

= E TestSessionBean name: ;
o= ;
description:
mappediame:

© 2008 IBM Corporation WASv7.,Java EE 5 tools & RAD 7.5
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RAD 7.5: Creating an EJB 3.0 project

= The EJB project creation wizard now defaults to
EJB 3.0 support

= Older EJBs are still supported and available as
options in the drop down list

= You cannot create
» EJB 1.1, 2.0, 2.1 bean in an EJB 3.0 Project
» EJB 3.0 bean in a non 3.0 compliant project

WASv7.,Java EE 5 tools & RAD 7.5
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import javax.ejb.S5tateless;

-T-_l,-"*:-:'*:-:'
* Dession Bean implementation class for: TestSessionBean

w
®f

EEtateles=s

public class TestSessionbBean implements TestSessionbBeanBemote, TestSessionbeanlLocal

H

= When the stateless bean is created, an annotation
@Stateless is added to mark it as a stateless bean

= The local and remote interfaces are created and the bean
Implements them automatically

WASv7.,Java EE 5 tools & RAD 7.5
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Example: MDB generated by wizard
e :

package com.test.mdb;

Zimport javax.ejb.hctivationConfigProperty:
import javax.ejb.Me=ssageDriven;
import javax.jms.Message;
import javax.jms.Messagelistener;

'.l"r**
* Message-Driven Bean implementation clas=s for: MHMessageBean
k3
*f
EMez=zagelriven |
activationConfig = { BhctivationConfigProperty|
propertylName = "destinationType", propertyValue = "javax.jms.Topic®
bor)

poblic class MessageBean implements Messagelistener {

1 llf'k'k
* [fzee MessagelistenerfonMessage (Mes=sage)
*f
pubklic void onMessage (Message message) {
Jf TODD LButo-generated method stub

© 2008 IBM Corporation WASv7.,Java EE 5 tools & RAD 7.5
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EJB 3.0 deployment descriptor

= The EJB deployment descriptor is now optional with
EJB 3.0

= The deployment descriptor is only generated into the project
If the option to generate a descriptor was selected during
the creation of the EJB 3.0 project

» As an alternative you may right click on the EJB module and select
Java EE > Generate Deployment Descriptor Stub

= The ejb-jar.xml file is available to be edited with the
deployment descriptor editor

» This editor allows developers to add, remove, and modify EJB
descriptions and properties

WASv7.,Java EE 5 tools & RAD 7.5
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Example: deployment descriptor
——

([@) *bm-ejb-jar-bnd. mi [|1‘| TestSessionBeanLocal java

EJB Deployment Descriptor Editor

= [%§ E38 Project (TESTEIE) &
EI@ Enterprise Beans
8 Session Bean (TestSessionBean

! |

ID

5

EJB Structure

i

Details
EJB Name™: | TestSessionBean |
EJE Class: | com.duck.ejb.session, siide. TestSessionge| | Browse. .. |
Bean Type: | Stateless
Transaction Type: |
Home Interface: | | [Browse... |
Local Interface: | | [Bmwse...]
Local Home Interface: | | [Browse... |
Remote Interface: | | [Browse... |
Service Endpoint: | | [Browse... |
Description: my session bean ~

b

Mapped Name: | |
~ Icon (optional) &
Large icon: | ' [ramse... |
smallicon: | ' |Bromse... |

© 2008 IBM Corporation
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Entity Beans

= Entity Bean support has changed for EJB 3.0.
» Entity Beans are based on the EJB 2.x specification

» WAS currently does not support 2.x Entity beans in a EJB
3.0 Jar

= The Java Persistence API (JPA) was introduced
with the EJB 3.0 specification as an option to 2.x
Entity beans

» JPA provides a simplified model for working with
persistent data

WASv7.,Java EE 5 tools & RAD 7.5
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JPA development tools overview

= New JPA projects and JPA views
» Add JPA support to existing projects by enabling the JPA facet

= Tools for working with JPA annotations

» Java editor provides validation, content assist and quick fixes for JPA
annotations

» Modify annotation properties in JPA details view or annotations view
= JPA XML editors (persistence.xml, orm.xml)

= Wizards for creating and initializing object-relational
mappings
» Create tables from entity classes (top-down)
» Create new entity beans from existing database tables (bottom-up)

WASv7.,Java EE 5 tools & RAD 7.5
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JPA Development perspective

1

Display Java
classes, work
with deployment
descriptors in
the main panel

@ wpa Development - TopDownExample/src/com/ibm/sample/jpa/Property.java - Rational Application Developer

File Edit Refactor Source Mavigate Search Project Data  Web References Debug

Hun  Window Help

The Package
Explorer view
shows project

structure

Work with data
connections in
the Data Source
Explorer view

IB-E @[5 -0 -Q- | S#F-|®P-[se]s |- AR Ei| ¢ Papevebp.. =
___________________________ 1
| [% Package Explarer 22 = BT Property.java 52 = El' & e 2 O= Outlin} =l ] 1
= <'===D VI package com.ibm.sample.jpa: O =2 G?g Property I
= &;‘J TopDownE:xample | Ll i i i X | ; I@ I 1
| 555 S Fimport java.io.Serializable; | B8 owner
| El‘fﬁ com.ibm.sample.jpa I i B8 addressl |
: - HEntity | -8 addressz 1
1 E--1J] Property.java | . . o | :
E@ Property I public class Property implements ZSerializable In - by city I
I L bh sddress] public Property() {}: [ b state
I - + addressz I 8 zip !
H—- 1 EId protected int ID; | L price I
______ oI 1 protected 3tring owner: | 1
I bl protected 3tring addressl; 1 I
1 5___0 price I protected String addressz:; 1
| state | protected String city; |
I #in 1 protected String state; I 1
| i & Praperty() I protected String =zip: | |
R protected double price:;
| (= META-INF I | 1
[-m WebSphere Application Server v7.0 [W 1 !
| B JRE System Library [Websphers F'.ppli!
[2 Problems | %2 pa Detals 52 =0 I
Map As: |Entity )= I
=G Databases Mame: |DeFauIt (Property) |Z| |
I S PropertyDE (Apache Derby v, 10,1.2, Table: |
| &= opa Data sources Mame: |Default (Property) =] 1
I Catalog: |DeFauIt 4] Iz‘ |
: Schema; |Default ) = I
1
I ¥ Attribute Overrides 1
: b Secondary Tables I
1
‘I I ’ P LYY Y - @ x
J nj 0 items selpched J

© 2008 IBM Corporation

JPA
Structure
view provides
a tree display
of the data in
a JPA class

Highlight a
JPA construct
in the JPA
Structure view
to see
configuration
details in the
JPA Details
view
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Configure a database connection in
the project

» Database needs to contain a table to use
for generating an entity

Right-click on the project in the Project
Explorer and select JPA Tools >
Generate Entities

Choose the appropriate connection
and schema in the Database
Connection panel

Select the table to use to create an
entity

Tools automatically generate a class

based on the table structure

» Includes data members and accessor
methods

Creating entities from database tables

@ Generate Entities !IE[ E
Database Connection
Reconneck ta the database.
Database Sektings
Connection: I PropertyDE j
Schemat I APP j

(Mote: Must have active connection to select schema)

Add connections..,

Reconnect...

f) Generate Entities !EI E
Generate Entities from Tables
& The use of the default package is discouraged.

(@ Source folder; I BotkomUpExamplejsrc Browse... |
Package: I com.ibrm.sample Browse..., |
V¥ Synchronize Classes in persistence.sxml

Tables:
Table | Entity Mame | Select Al |
PROPERTY Property
Deselect Al |
(7 < Back Text = | Finish I Cancel

WASv7.,Java EE 5 tools & RAD 7.5
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Creating a database table from an entity

F R .

[ Table.ddl 52 . E=] PROPERTY ] = O | 5% outline 52 =34

Connection profile =
’7Type: IDerby_lD.xj Marne: IPropertyDB j Database: |DE j Status: Commecked | || =] Create Tahle

CEEATE TABLE FProperty (ID IHTEGER HOT HULL, addressl VBRC];I

e

i

fT —
{21 Problems (@ Javadoc (@ Declaration ﬂ:% Annatations | L SOL Resulks &3

il'ype query expression here
Status

NSNS

| operation | |CREATE TABLE Property (ID INTEGER NOT NULL, addressi b - |

|

v Succeeded
v Succeeded

“BPP"."PROPERTY"
CREATE TAELE Propetty (ID INTEGE... {0 rows affecked)

= Use JPA entities to create
database tables top-down

» In the Package Explorer view, right-
click the JPA project and select
JPA Tools > Generate DDL...

» The JPA tools create a file named
Table.ddl in the META-INF
directory of your JPA project

» Double-click Table.ddl to open it

» Configure the connection properties
using the dropdown menus at the
top of the editor

» Right-click in the editor and select
Execute All

» Check the SQL Resulis view to see
if the table generation was
successful

© 2008 IBM Corporation
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RAD 7.5: Web services

*JAX-WS development wizards
» Top down
» Bottom up
» Client generation wizards

“Policy Set support

WASv7.,Java EE 5 tools & RAD 7.5
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Web service provider wizard

© 2008 IBM Corporation

@ web service

Web Services

Select & service implerentation or definition and move the sliders to set the level of service
and client generation,

I[=] E3

web service tvpe: |T0|:| down Java bean Web Service

Service definition: | TWSFPLabl\WebContent 'WEB-IMNF/wedlfwsfplabl swsdl

_ I _| Start service

2

Browse. .. |

L

Server: WebSphere Application Server w7.0

wWeb service runtime: I6M WebSphere JAx-WwWS

—

=0 e O

=t Q El Service EAR project: WSFPLab1EAR

Client type: |Java Proxy

3 _| Mo client

1. Configuration: Mo client generation,
- - - =

- |- 1o (F)

|- = El

-

™ Publish the Weh service
[ Monitar the Web service

v oOverwrite Files without warning

() < Back Mext > | Finiish I

Cancel

WASv7.,Java EE 5 tools & RAD 7.5
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Web service client wizard

& web Service Client

Web Services

Ik

m

JillY

Select a service definition and move the slider to set the level of client generation.,

Service definition: I P SFEPLab1 fwebContent MWEB-IMF fwesd| fwsfplabl  wsdl Browse, ..,

Client type: IJava Proeey

_| Deploy client
Configurating:

N g C&rver: WiebSphere Application Server V?D
de] L Web service runtime: I6M WebSphere J4:-

L Clisnt project: WSFPLab1
@& | E Client EAR project: WSFPLablEAR

[ Monitor the Web service

W Cverwrite files without warning

(7 % Back, Mext = | Finish I Cancel

© 2008 IBM Corporation WASv7.,Java EE 5 tools & RAD 7.5
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Policy Set support

Gallerﬂ =

=R

B2 src

ElEE com.ibrm.was, ws
m LabServicePt
m LabServiceP:

; |I| CbjectFactol

-2, Libraries

= Services

LAY {http: ffcom/fibmjiwas

#-= JavaScript Support

== webCantent

(= META-INF

+-E2 WSFPLah1EAR

E'ﬁ
=
E

4
(6] pa E::?\\ 5?] ] Tﬂ

DEW

Mo data components Found.

-
[J] LabServicePartImpl. java Eﬂ\\_

package com.ibm.was.wssample.beta. lab;

© Service Side Policy Set Attachment for WebSphere 7 services =] B

Bims Ag-d Mrelic. Gt A8 bt 4

@ End Point definition Dialog

eta. lab.

uh
ol S
2 I? g
A
_, [~ Application i
F | Service Name: I'-.-'-.-'SFF‘Lahl.war:{http:,l',l'cnm,l'ihm,l'was,l'wssampIe,l'heta,l'lah}LahSej
H I
Endpoink: I LabServicePort j
peration Mame: Isul:umit j
- Policy Set: [LTPA RAMP default |
Binding:
@ (84 I Cancel |
1]
[]
@ @ = Back | Mext = || Finish I Cancel |
WebSphere

© 2008 IBM Corporation
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Policy Set support

@ Preferences H=] &3

= o=

Jbvpe Filker text Service Policies

[+ General
Active Correlation Technology

» LTPA RAMP default {details)

Adrinistr ative Opkions
Adopter Usage Reparts
Agent Controller
Analysis

ank

Backward Compatibility
Conneckivity

Help

InstallfUpdate
Internet

J2EE

Java

Jawascript

JPA

Jython

Logging

Modeling

Plug-in Development
Report Design
Run/Debug

Server

Service Policies

SIp

SQL Development

SGL Editar

3GQLI Applications

- Stared Procedures and User-De

- we
----- £

----- (3

¥~ Profile Compliance
l@% wehSphere Client Named Bindings
hSphere Policy Sets

LTPA RAMP defaulk
LTP& SecureConversation

LTPA WaSecurity default

RAMP defaulk

S5L Wi Transaction
Secureonversation

|sername FAMP default
Username SecureConyversation
Username WSSecurity default
Wsaddressing default
WSHTTPS default
WiReliableMessaging 1_0
wWaReliableMessaging default
WiReliableMessaging persistent
WSSecurity default
W5Transaction

[]—--@E webSphere Server Named Bindings

¥ Set as defaulk

Descripkion:

using Web services technologies.

Dependencies:

The Reliable Asynchronous Messaging Profile (RAMP) 1.0 is a profile, in the Fashion of ;I
the Ws-I profiles, that enables, among other things, basic B2E integration scenarios

|

Mone

=

Tearm

Walidation

W'eh

Weh Services

xhoclet

- | | Restore Defaults | Apply |
IT' Cancel |
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WAS v7 Jython Library Support

= WAS v7.0 server added built-in Jython script
libraries

= Only available in WAS v7.0 server.

= Jython library support includes:
» New preference to the Jython preference page

» Content-assist/code completion to the Jython editor for
the new script libraries.
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Jython Library -Content assist example

% *NewScript.py 2 = O || &= Outline (E Snipp
# A palette is not availabl
¥l # TODO: enter JYTHON code and save -
#

wsadminNode = AdminControl.getNode ()
print "Node name" + wsadminNode

Admin
= Adminapplication AdminServerManagement
AdminBLA : ; 2 . &
i (This script object is only supported on WebSphere Application Server V7)
Ackmincliots The AdminServerManagement script library provides script
AdminJMSs procedures that configure, administer, and query server settings.
AdminJDBC The AdminServerManagement script library provides the following script procedures.
T ;o display detailed information about each script procedure, use the help command
. r
b i il " |the AdminServerManagement script library, specifying the name of the script of

AdminClusterManagement

AdminModeManagement
AdminModeGroupManagement

1]

Admins ithorizations
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RAD References

= What’s New in RAD 7.5 Technote

» hitp://www-
01.ibm.com/support/docview.wss?rs=2042&uid=swg2701
4208

= RAD 7.5 InfoCenter

» http://publib.boulder.ibm.com/infocenter/radhelp/v7r5/inde
X.|Sp
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T % ff TP

Traditional Chinese

Cnacun6o (Gracias

Thank You

RRRRRRR
English

< Mereci Obrigado

Brazilian Portuguese

»
Grazie z lﬁi Danke

Simplified Chinese

. e e ZAleEL| L
b 65T(D) HUNES ZENELLE -
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Trademarks, copyrights, and disclaimers

The following terms are trademarks or registered trademarks of International Business Machines Corporation in the United States, other countries, or both:
IBM WebSphere

Product data has been reviewed for accuracy as of the date of initial publication. Product data is subject to change without notice. This document could include technical inaccuracies or
typographical errors. IBM may make improvements or changes in the products or programs described herein at any time without notice. Any statements regarding IBM's future direction
and intent are subject to change or withdrawal without notice, and represent goals and objectives only. References in this document to IBM products, programs, or services does not imply
that IBM intends to make such products, programs or services available in all countries in which IBM operates or does business. Any reference to an IBM Program Product in this
gocumgnt is nodt intended to state or imply that only that program product may be used. Any functionally equivalent program, that does not infringe IBM's intellectual property rights, may

e used instead.

Information is provided "AS IS" without warranty of any kind. THE INFORMATION PROVIDED IN THIS DOCUMENT IS DISTRIBUTED "AS IS" WITHOUT ANY WARRANTY, EITHER
EXPRESS OR IMPLIED. IBM EXPRESSLY DISCLAIMS ANY WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE OR NONINFRINGEMENT. IBM shall
have no responsibility to update this information. IBM products are warranted, if at all, according to the terms and conditions of the agreements (for example, IBM Customer Agreement,
Statement of Limited Warranty, International Program License Agreement, etc.) under which they are provided. Information concerning non-IBM products was obtained from the suppliers
of those products, their published announcements or other publicly available sources. IBM has not tested those products in connection with this publication and cannot confirm the
accuracy of performance, compatibility or any other claims related to non-IBM products.

IBM makes no representations or warranties, express or implied, regarding non-IBM products and services.

The provision of the information contained herein is not intended to, and does not, grant any right or license under any IBM patents or copyrights. Inquiries regarding patent or copyright
licenses should be made, in writing, to:

IBM Director of Licensing

IBM Corporation

North Castle Drive

Armonk, NY 10504-1785

U.S.A.

© Copyright International Business Machines Corporation 2007. All rights reserved.

Note to U.S. Government Users - Documentation related to restricted rights-Use, duplication or disclosure is subject to restrictions set forth in GSA ADP Schedule Contract and IBM Corp.
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